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2. Gotothe Elements Gallery (Gallery) below the Toolbar and select the Slide Themes gallery. Select the
design theme that fits your need. The Theme is applied to the entire set of master layouts. (You can also
apply Slide Themes without having to go to the Slide Master view, however in the Slide Master view you can
further customize the appearance and elements of the individual master layouts.)
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3. You can also insert an image as the background. Go to the Toolbar and select Picture and click Insert
Picture. Select your image file and click Insert. Right click on the image and go to Arrange and select Send
to Back. The text placeholders in the layout templates will be on top again.

4. Click the Close Master label on the upper left gallery toolbar above the Gallery to return to your Normal
view when done.
1Pl H &= o

. Mew Open Save Print Undo

| £ close Master @I £

:

| Slide Themes |
Built—in Theme The
Apply Slide Theme |—
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Developing Interactive Lectures

Apply Animated Effects with Custom Animation

1. Highlight the object or text placeholder you want to apply an animation effect in the slide.

2. Gotothe Toolbar and select Toolbox. The Toolbox window appears. The Custom Animation panel is the

third tab with the grey Star icon in the Toolbox window.
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3. Nextto the Add Effect label in the Custom Animation panel, there are four groups of effects: Green star for
Entrance effects, yellow star icon for Emphasis effects, and orange star icon for Exit effects. When you
click on a specific star icon, the group of effects appears in a separate window.

4. Click on More Effects, the Animated Effect window opens to reveal the sub groups of effects in a scrollable
window. Check the Show preview button at the bottom of the Animation Effects window to preview a
selected effect in your slide. Click OK when done.
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| (B) Add Effect: [
Animation Effects
J I Entrance Emphasis Exit |
¥ Basic
Change Fill Color
Change Font
Change Font Color
Change Font 5ize
Change Font Style
Change Line Color
Grow/Shrink
4 _?_?;:Spa rency Dissolve In
4| s My Presen o
Bold Flash Faculty Development Peek In
Brush ©n Color Plus
Brush On Underline Random Bars
Color Blend Random Effect
Color Wave Split
Complementary Color Strips
Complementary Color 2 Wedge
Contrasting Color Wheel e
Darken Wipe s
m avl | B S e =—r=
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5. The selected effect appears in the Animation order panel. For most effects, you can manipulate their

attributes such as Start (user controls on when to start the effect on slide); Property (direction of the effect
in motion, such as from left, from top, etc.), and Speed (motion speed of the effect). If you want to

manipulate more attributes, explore the group of buttons below Speed: More Effect Options button; Timing

button; and Text Animations button.
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» Mare Effect Options

» Timing
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If you want to remove, change, or play an effect, select and right click the effect in the Animation order
panel.

If you want to rearrange the order among the effects, select an effect and use the arrow icons to move it up
or down in the Animation order panel.
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Insert SmartArt

Developing Interactive Lectures

1. Inyour slide layout's text placeholder click the SmartArt Graphics icon and the selections appear (or

select SmartArt Graphics in the Gallery directly.)

| sideThemes | sise Layouts
Instrt SmartArt Graphic -
Click a SmartArt layout to =]
insert into document.

Click to add title
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2. Base on your need, select the apﬁopriate group of SmartArt objects on the left of the Gallery and the
options of that group appear on the right horizontally. To reveal more options, advance the number on
the right. Click on a miniature SmartArt object and the object is inserted in your slide.
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Theory and F?’ractice
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Click to add notes

3. Type directly in the text placeholders in the SmartArt or in the Text Pane on its right. Click the Close
icon on the upper right of the Text Pane when done. You can apply animation effects to SmartArt

objects as well in Custom Animations.
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Insert Media Object - Sound

1. Save your music files in formats such as .aiff, .wav, .mp3, etc. in the same folder of your PowerPoint
presentation.

2. Click the Media icon in the Toolbar above the Gallery. Select Insert Sound and Music. The File
Directory window opens. Go to your folder and select your sound file.

-~ Presentationl

@- iy 852 O
Shapes Table Media New Slide Slide Show Gallery 1
| e 5‘,' H Insert Movie... "
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3. Locate your spund file and click Insert. A dialog box appears asking you when the sound should start.

]

m) L] presentation1 ?l Q, searc

1l B o tationl & Ed Leadership.avi

1] narration.wav

How do you want the sound to start in the

C(-:\:_:)) slide show?
|

f. When Clicked \ ( Automatically \

4. After you made your choice on how to start, a sound icon representing your sound file appears in your
slide. Double click on the sound icon to hear the sound.

5. If you want to play a CD track, you can go to the Insert menu, navigate to Sound and Music, and select
Play CD audio track. The File Directoy window opens. Search for your CD and select the appropriate
track.

6. To manipulate more attributes of the inserted sound element, open your Toolbox window and select the
Custom Animation panel. Select the sound icon in your slide and click on one of the buttons in the
Custom Animation panel. For example, in Timing, you can customize any repeats, time delay to start,
etc. or in Media Options, you can customize when to stop playing, hide the icon while not playing, etc.
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Insert Media Object — Movie

Developing Interactive Lectures

1. Save your movie file in .mp4, .m4v, .avi, or .mov file format in the same folder as the PowerPoint
presentation.

2. Click the Media icon in the Toolbar above the Gallery and select Insert Movie (Or go to the Insert menu
and select Movie). The File Directory window opens. Select your file and click the Choose button.

8 e Insert Movie
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3. The following dialog box appears asking you when the file should be played: automatically or when clicked.
Select your preference and the first frame of your movie will be inserted to your slide.

Testimony

+» Education Leadership

]ﬂ))

How do you want the sound to start in the
slide show?

( When Clicked ) (Aumma(icallv\

4. To manipulate more attributes of the inserted movie, open your Toolbox window and apply the following

steps:
a.

Select the Custom Animation panel. Select the movie image/object in your slide and click on one of
the buttons in the Custom Animation panel to customize the Timing, such as any repeats, time
delay to start, etc. or the Media Options, such as when to stop playing, hide the icon while not

playing, etc.

Select the Formatting Palette panel. Select how you would like the movie to be displayed, whether
to show the play controller, etc.

(5] ) Formatting Pa]ette

E = *Illlﬂ“\;é

¥ Movie

.' \ Ed Leadership.avi
Duration: 00:29

Play:  Autcmatically -
Volume: | Medium -
':' Hide During Show

E Play Full Screen

':' Loop Until Stopped

E Rewind After Playing

m Hide Controller
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H 0.8 Formattlng Palette
Format the Appearance of Image Objects . RS %
1. Select the image object in your slide. Open the Toolbox window in the Fafictize
Toolbar. Select the Formatting Palette panel. There are many groups of Recolor: || ¥ Crop:
functions that enhance the image. Shape: [{fi * Transparent Color: [

2. Inthe Quick Styles and Effects group there are six functions: framing the Brightness:  — U 0%  |%]
images; inserting new shapes; adding shadow or 3D effects; and WordArt. Contrast:  —— U |ox [4]
3. Inthe Side, Rotation, and Ordering group, you can group and ungroup Transparency: "= lo% |4

elements of an image from the Clip Art Gallery, or rearranging the layer [ Replace... ] Effects...
order of these elements in the Ordering functions. -
a. To group or ungroup objects first select all the objects then right £ i ol Reser
click to navigate to Grouping and select Group or Ungroup. e T
b. To send an object to the back or front, select the object, right click @O O =0 abe
and navigate to Arrange and select Send to back or Send to ' '
front. Y
. . ol ol =l ol
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1, - - = 4
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8
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Order[ng E - ™ e

" e hd . Align: |ﬁE v Distribute: ﬂﬂ!] v
Arrange: '-E‘ * Grouping:
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e » Shadow
) Y » Reflection
'- - b Hyperlink
| B b Document Theme
R » Slide Backgreund
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Cut X
4 Copy ®2C
Paste ®V
q Change Picture...
Save as Picture...
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Arrange » Bring to Front
— Send to Back
== Custom Animation... Bring Forward
Action Settings... Send Backward
Enrmat Pirtirs

4. The Hyperlink option lets you assign a URL to the object. Test the link in Slide Show view mode.

5. You can manipulate the color scheme of the slides in Document Theme and change the background color
in Slide Background.

6. You can also right click on the object to access most of the Formatting Palette’s functions.
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Insert and Manipulate Shapes

1. Gotothe Toolbar and click Toolbox. Click the second icon for Object Palette. In the Object Palette panel
select the All Shapes icon to reveal the shapes in a scrollable window. Click and drag the shape to your

slide.
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2. You can also access 571;pes by going to the Toolbar and select Shapes.

- 76%

- *\, Lines and Connectors b
[L] Rectangles
ﬁBasic Shapes

D @9 Block Arrows

%= Equation Shapes
T‘Zr"? Flowchart
ﬁStars and Banners

k 1 |53 Action Buttons »

3. Highlight the shape in your slide and go to the Formatting Palette panel for more functions to manipulate

the appearance of the shape.
4. You can type directly in the shapes. To change the style of text, use the functions in the WordArt in the
Gallery and/or the function groups in the Formatting Palette.
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Create Action Buttons

1. Gotothe Toolbar and click Toolbox. Select the Object Palette in the Toolbox window. In the Object
Palette panel select the All Shapes icon to reveal the shapes in a scrollable window.
The Action Buttons are at the bottom of the scrollable window.

B 2O AP idd &
2. Oryou can go to the Toolbar and select Shapes. In the drop down list of shapes, navigate to the bottom
and select a button from the group of Action Buttons. These buttons have preset action settings that
correspond to the meanings of the graphic icons. The blank one allows you to set your own action as well as
text or graphic icon.
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3. Click and drag the button to your slide. The Action Button is inserted to your slide.

4. If you want to set or change the settings, right click on the button and select Action Settings and the
Action Settings dialog box appears. (Or you can select the button and go to the Slide Show menu and
select Action Settings)

5. Select the Hyperlink to radio button as your action option and click on the down arrow of the drop down
menu, your Hyperlink action option list appears. Drag the scroll bar to reveal more options for hyperlink
destinations, for example, you can select a slide in your file or select another PowerPoint file as the
hyperlink destination. Click OK when done.

6. Test button actions in Slide Show view mode.
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